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Printer location environment & supply storage instructions 
The recommended printer location environment is in an office environment with controlled room 

temperature. 

Avoid exposing the printer and the supplies (tape rolls & ribbon cassettes) to direct sunlight. 

Store the supplies in their original packaging (plastic bag & carton box) in a dark cabinet. 

System requirements 
The minimum computer specifications are: 

• CPU: Intel or compatible x86 family processor 

• Memory: 2 GB or more RAM 

• Hard drive: 1 GB of available disk space 

• 32-bit or 64-bit Windows operating systems: Windows 8.1, Windows Server 2012, Windows 

Server 2012 R2, Windows 10, Windows Server 2016 or Windows Server 2019 

• Microsoft .NET Framework Version 4.6 

• Display: 1920×1080 or higher resolution monitor with Windows (text font) scaling set to 100% 

• Connection: USB port or ethernet LAN port.  

Package contents - what is in the box 
 

   
SMS-R1 Printer Power & USB cable Squeegee 

 

 
 

 
Dust cover Spare cutting plotter knives QuickStart Guide 
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Setup & Installation 

Turning the printer on 
Use a grounded wall socket. 

   
Place the SMS-R1 on 

a steady surface 
Connect the power cable Turn the printer ON 
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Loading ribbon cassette & tape roll 
In order to start using your SMS-R1 you will need to insert two types of supplies: 

  
Ink ribbon cassette Printable tape roll 

 

Loading the ribbon cassette: 

1. Make sure the black closed caps of the cassette are facing towards you and the open caps are 

pointing towards the printer. 

2. Make sure the flat side of the cassette is faced upwards. The arrow labels should be on top with 

the arrows pointing towards the printer. 

3. Insert the ribbon cassette from the side of the printer. If you notice any friction please take the 

cassette out and check if it is correctly positioned. 

    
 

Loading the tape roll: 

Attention: Before placing the tape make sure the printer is turned ON and a ribbon cassette is loaded. 

1. Open the back lid and place the tape roll inside with the printable side up. 

2. The printer will now detect a tape roll is placed. 

3. Manually feed the first part of the tape until the printer detects it and starts to automatically 

feed the rest of the material. 
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Printer controls (touchscreen) 
With the built-in touch screen you can control the printer and adjust cutting & network settings. 

 

 
 

 

 

 

 

 

 
 

 

Our tape materials are pre-programmed with the recommended cutting depth settings. 

You should only change the settings if you notice that the current settings are insufficient. 

Open / Close 

tape collector 

Eject ribbon cassette Eject tape roll 

Cut tape 

Edit cutting 

settings 

Feed tape 

backward 

Feed tape 

forward 

Tape quantity 

(meters) 

Ribbon quantity 

(meters) 
Device information & network configuration 

(hold logo for 3 seconds) 

Increase / Decrease 

cutting depth 

Cancel settings Perform test cut Confirm settings 

Cutting settings 

Increase / Decrease 

cutting depth 

(including laminate) 
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On the main interface, hold the SMS-R1 logo on the bottom for 3 seconds to access the device 

information & network configuration. 

 

 

 

            

Device information & 

network configuration Configure fixed IP 

Set device to 

automatic IP address 

from DHCP server 

Set device to 

fixed IP address 

Enter numbers Confirm / Cancel settings 
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Installation of Windows printer driver 

Using USB connection 

Printer setup: 

1. Connect the power cable but do not connect the USB cable yet, turn on the printer. 

2. Insert a ribbon cassette and a tape roll. 

Printer driver installation: 

3. Close all open applications. 

4. Download the SMS-R1 Printer Driver from our website: https://www.rebo.nl/en/downloads 

5. Extract the zip file. 

6. Open the extracted folder and start Setup.exe. 

7. Follow the on-screen instructions and when prompted: Printer or driver? Choose option: 

Recommended for USB setup: install driver only. 

8. Click Next, and click Done when successfully completed. 

9. Connect the printer USB cable to the computer and printer and the printer will be automatically 

installed as a printer in Windows. 

10. Finished! 

 

 

[Troubleshooting in case USB Plug & Play installation fails: login as a user with local administrator rights. 

Then try again, or manually right mouse click > Remove the SMS-R1 device in hardware category 

"Unspecified". Then unplug and plug back in the device or press scan for hardware changes button for 

good automatic conversion to printer object.] 

  

https://www.rebo.nl/en/downloads
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Using LAN connection 
For 1 user/computer to 1 printer: you can use a direct TCP/IP port or configure a shared printer. 

For more than 1 users/computers to 1 printer: we recommend to configure a shared printer (queue) in 

order to make sure the print jobs are correctly processed (applies to driver version 18 released in May 

2021 and newer). 

Printer setup: 

1. Connect the power and LAN cable, turn the printer ON. 

2. Insert a ribbon cassette and a tape roll. 

View printer IP: 

3. Hold the SMS-R1 logo in the bottom center of the printer touchscreen for 3 seconds to display 

the printer IP address and optionally configure the network settings. 

Printer IP configuration: 

4. By default an automatic IP from your DHCP server is enabled. You can use this IP, or optionally: 

a. If you want to set a fixed IP, press the FIXED IP button. Set the IP address, subnet mask 

and gateway and press Finish. The device will restart and chosen fixed IP will be applied. 

b. If you want to create a DHCP IP address reservation based on printer MAC address, you 

can see the printer MAC address in this window. Restart the printer after you have 

added the address reservation to your DHCP server. After doing so, view the new IP and 

continue the driver installation below. 

Printer driver installation: 

5. Download the SMS-R1 Printer Driver from our website: https://www.rebo.nl/en/downloads 

6. Extract the zip file. 

7. Open the extracted folder and start Setup.exe. 

8. Follow the on-screen instructions and when prompted: Printer or driver? Choose option: 

Recommended for LAN setup: install printer driver and printer. 

9. The default printer name is SMS - R1, you can change printer name here. 

10. Click button Create TCP/IP port. 

11. Click Allow at the Windows firewall question to let the installer search for SMS-R1 printers in 

the LAN network. 

12. Select your printer, the IP address will be copied to the IP address field. 

Or you can manually enter the IP address of the printer, click Add. 

13. Click Next, and click Done when successfully completed. 

14. Finished! 

  

https://www.rebo.nl/en/downloads
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Upgrading software for existing installations 

Upgrading Windows printer driver 

Message for server administrators: we recommend to use our printer driver installer instead of 

Windows GUI to upgrade the printer driver. This provides a seamless upgrade process which does not 

require a restart of the Windows printer spooler service after upgrading the driver. 

1. Download the SMS-R1 Printer Driver from our website: https://www.rebo.nl/en/downloads 

2. Extract the zip file. 

3. Open the extracted folder and start Setup.exe. 

4. When prompted: Driver or Printer? Choose option: 

Update (keep current printer port and settings) driver. 

5. Optional step: only necessary in case of upgrading a shared printer (queue), after upgrading 

server, on the client computers: right click the shared printer’s queue and choose option Update 

driver. 

Otherwise the first print job will fail because driver on client is outdated and needs to be 

upgraded first before proceeding. 

6. Finished! 

[Troubleshooting in case USB Plug & Play installation fails: log off all users and logon as a user with local 

administrator rights. Then try again, or manually right mouse click > Remove the SMS-R1 device in 

hardware category "Unspecified". Then unplug and plug back in the device or press scan for hardware 

changes button for good automatic conversion to printer object.] 

Upgrading printer firmware 
1. Turn the printer power OFF, wait a few seconds and then turn it ON again. 

2. Download the latest SMS-R1 Firmware from our website: https://www.rebo.nl/en/downloads 

3. Extract the contents of the zip file. 

4. Start your label designer application and print 1 label to the printer so the SMS-R1 Manager 

application will open. 

5. Click the Advanced button, click Upgrade firmware button. 

6. Browse to the extracted folder of the zip file, select the firmware file: softwareUpdate.zpl and 

click Open. 

7. It can take up to 30 seconds before firmware upgrade starts. Do not send the file twice. 

Look at the printer display and verify the printer has started the firmware upgrade. 

 

Warning! Do not turn off the printer in stage 1 and 2 of firmware upgrade! 

                Stage 1: red screen. Stage 2: black screen (approximately for 30 seconds). 

 

When both Stage 1 and 2 of upgrade process are completed, the printer will ask you to manually 

turn the printer OFF and ON by using the power switch to complete the process. 

8. After restarting, you can view verify the firmware version by holding the SMS-R1 logo in the 

bottom center of the touchscreen for 3 seconds. 

9. Finished! 

 

After upgrading the printer firmware we strongly recommend to upgrade the printer driver too. 

https://www.rebo.nl/en/downloads
https://www.rebo.nl/en/downloads


12 
 

Manager application controls & print process logic 

Label dimensions 
Label dimension settings in Manager application: 

 

The label dimensions can be dynamically set based on the label data objects in your design (selected by 

default), or based on the original document size of the label design. 

You could also set a specific label size by inserting your own custom cut shape and set a specific size. 

The orientation of the labels (portrait or landscape) is derived from design document settings. If you 

want to rotate the labels 90°: change Landscape to Portrait or the other way around in your label design 

application. 

Setting Original 
Uses the document size received from the print application as the label dimensions. 

Use this option if you need a very specific label size. 

Setting Optimized 
Automatically sets the dimensions based on the label objects as the new label dimensions. It ignores the 

label design application’s document size. White space outside the label objects is trimmed, and a 

horizontal and vertical margin are added. The margin sizes are automatically scaled based on the size of 

the label objects. You can change the margins to your preference. 

 

An advantage of this method is time saving as you don’t have to set a specific document size: all the 

surrounding white space in the label is trimmed so you don’t have to be too cautious about the label 

edges and margins. When previewing the labels in the manager, you can change the margins to fit as 

many labels across the width of the tape as possible to optimize the use of the ribbon and tape. 

Adaptive size for variable label object sizes in label set 

When using Optimized dimensions, you can use option adaptive size for variable label sizes in the same 

label set / job. When the use of variable data results in different label object sizes (for example when 

printing a list of names, the text fields will have different lengths) you also have the option to set the 

optimized size for each label individually (default option is set to largest label in the label set).  
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Cutting the labels 

Automatic cut shape function in Manager application: 

 

There are two options to cut out your labels: let the Manager generate a rounded rectangle shape 

automatically for which you can make small adjustments before sending the final print job to the 

printer, or place a custom cut shape image on the label design yourself. 

Automatic cut shape: (rounded) rectangle 
If you don’t provide a custom cut shape, the manager will automatically generate it. 

You can change the generated cut shape by changing the optimized dimension’s horizontal and vertical 

margins, and the corner radius. 

Custom cut shape 
If you have the NiceLabel label designer application installed, you could also place a rectangle or 

circle/ellipse object to create a custom cut shape. 

Another option is to add a cut shape image from the Shapes/Cut folders of the Graphical Symbol Library 

V4 for SMS label printers. 

 

You can also design your own custom cut shape in a vector art drawing application like Adobe 

Illustrator, CorelDRAW or Inkscape. 

 

No matter which application you use, the cut shape color must be set to RGB Magenta (RGB values of: 

R:255 G:0 B:255) and the thickness of the line must be 0,09 mm or smaller. 

 

If you want to import your custom label shapes into NiceLabel, export your design as a SVG image file 

(.SVG extension) with setting: high quality. See next page for application specific settings. 

 

If you place a custom cut shape on your label design, the Manager detects it and the Manager’s own 

automatic rounded rectangle cut shape will be automatically disabled. 

Examples of custom cut shapes: 
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How to set a NiceLabel rectangle or ellipse object as a cut shape 

Set the object properties to: Thickness: 0,09 mm, 
Outline style: Solid and Fill style: None. 
 

When selecting the outline color RGB Magenta, 
choose the bottom right color as shown: 

 

 
 
 

Select a cut shape from the Graphical Symbol Library V4 for SMS label printers 

This requires the Graphical Symbol Library V4 for SMS label printers to be installed on your computer (if 

you don’t have it please download it from our Getting Started webpage or contact our support team). 

In NiceLabel, insert a new image object and browse to the Graphical Symbol Library, select the Shapes 

directory. These directories each contain a Cut directory with various cut shape images. 

 

Create a custom cut shape with other design or label software (5 examples) 

See the Appendix section at the end of the user manual document for specific custom cut shape 

instructions per software application: 

Appendix A: How to set an Adobe Illustrator path as a cut shape 

Appendix B: How to set a CorelDRAW path as a cut shape 

Appendix C: How to set an Inkscape path as a cut shape 

Appendix D: How to set an AutoCAD path as a cut shape & general AutoCAD settings 

Appendix E: How to set a Bartender path as a cut shape 
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Laminating your labels for ultimate protection 
Laminate option in Manager application: 

 

Enable the Laminate option to manually laminate your labels before they will be cut out by the printer. 

After printing the labels the printer will feed the labels out of the front of the printer, allowing you to 

laminate the printed labels by hand. Watch the instruction video about laminating for detailed 

instructions. After applying the laminate press the Confirm button on the printer touchscreen display to 

confirm you are finished laminating the labels. The printer will feed back the labels and will cut out the 

label shapes. 

The printer applies extra knife pressure to handle the added laminate layer. You can set the added knife 

pressure level on the printer touchscreen display Cutter settings. 

We recommend you to do a short laminating test job to verify cutting depth is OK before sending a large 

print job. 

Link to YouTube instruction video: SMS-R1 | Laminating function 

  

https://youtu.be/b8xHIaU7WII
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Label quantity / number of copies 

Label quantity options in Manager application: 

 

In the number of copies field you can set the number of labels that will be printed. The total length is 

displayed so you exactly know how much ribbon and tape you will need for the job. 

Enable option Cut per group of # labels to group labels and cut off the tape after each group. 

 

Detailed explanation about the Number of label copies field in NiceLabel vs the Number of copies field 

in the Manager: 

Identical copies of a single label 
If the label data is fixed and there is no variable data detected between the labels themselves then the 

requested label quantity in NiceLabel is transferred to the Manager’s Number of copies field. In the 

Manager, you are able to change that same number of identical label copies before sending the final 

print command. 

Variable data label set 
When you are using a counter variable or a database connection in your label, the print job will consist 

of a set of individual labels. The complete print job will be collected, then the Manager will open. When 

using variable data, the value of the requested number of labels in NiceLabel is not transferred to the 

Manager’s Number of copies field. The number of copies field can now be used to print multiple sets of 

the variable label data that was received. 

Margin between copies 
The offset between the labels. We recommend to use a minimum of 1 mm so the excess tape can be 

easily peeled from between the labels without breaking. 

Total length and maximum length of a print job 
The total length of the print job is displayed, and in case of a large print job it also shows the amount of 

jobs it is split into. 

The limit of a print job you can send to the printer is 120 meter. It will be split into multiple sub-jobs 

depending on data type: 

- When you are printing identical copies of a single label: it will be split into 12 meter jobs. 

Example: a total print job of 20 meter will be split into 2 jobs: one 12 meter + one 8 meter job. 

 

- When you are printing variable data (a set of unique labels): it will be split into 2.5 meter jobs. 

Example: a total print job of 20 meter will be split into 8 jobs of each 2.5 meter. 
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Colors in your label job 
Color job options in Manager application: 

 

Every color which has been detected in your label design will be listed in the job list. For each color job, 

you can: change to another color, disable the color or add a white primer paint layer. 

Switch a color 
You can switch a color to another color by choosing a color from the dropdown list that appears when 

you click Original. The label preview will then update and show the new print preview. 

Disable a color 
You can disable a color by clicking On to switch it to Off. The label preview will then update and show 

the new print preview. 

Enable white primer paint 
You can enable printing a white primer paint for a specific color if you enable the Primer paint checkbox. 

You can use this function if you want to print a lighter ribbon color onto a darker colored tape, in order 

to get a proper ink color print. If you don’t enable white undercoat color, certain color combinations will 

mix, and the end result will not look like what you expect. 

If enabled, the printer will ask for the white ribbon cassette before printing the respective color job. 
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Material supply information 
Supply information in Manager application:

 

The Materials box displays the color and remaining length of the ribbon cassette and tape roll which are 

loaded in the printer. If you eject and insert another ribbon cassette or tape roll in the printer, the 

information will be updated automatically. 

It shows the color and the remaining length. This helps you to decide in sending the appropriate label 

quantity or replace the supply before sending the print job. 

Ribbon Saving feature and remaining ribbon length 

If the remaining length of the ribbon cassette is less than the length of the print job, it can be the case 

you can still print and complete your print job with the ribbon because the Ribbon Saving feature will 

shorten the amount of ribbon used. 

This requires Ribbon Saving to be enabled (default setting is On) and the color-specific length 

optimalization depends on the label design: important is the distance (+ offset required to activate and 

deactivate ribbon saving) of the specific color objects in between each other when printing multiple 

labels. 

Handling empty supplies 
If you are printing print a large print job a ribbon cassette or tape roll can run empty during the printing 
process. 
 
To prevent any unnecessary material waste we show the remaining length of the supplies in the 
Manager window. Besides that we have optimized the printer for handling empty supply situations: 
 

What happens when ribbon cassette runs empty? 
If the ribbon cassette runs empty during the print job, the tape will automatically feed backwards and 
you can replace the ribbon cartridge by a new one of the same color, it will then print the same color 
again on the same location on the tape. 
 

What happens when tape roll length is not enough? 
The required tape length is checked at the start of each print job. In case there is not enough length of 
tape on the tape roll, the printer will automatically feed the tape backwards back onto the tape roll 
core. Eject the tape roll and insert a new tape roll and confirm on the touch screen. The print job will 
continue. 
 
This way you can finish any large job without wasting any supplies and prevent missing labels in the total 
print job. 
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Print button 

 

If you have reviewed all print options and the print preview, click the PRINT button to send the jobs to 

the printer. From this moment on, just insert the requested ribbon cassettes in the printer. 

After you have clicked the PRINT button the text changes from PRINT to Reset all print jobs: 

 

You can click this button to reset all jobs. It resets the values to the point just before you clicked PRINT, 

preserving/restoring all other print job options you have set as well. 

Advanced settings 
Advanced settings window of Manager application: 

 

Click the Advanced button in the Control area to open the Advanced settings window. 

Language and length units: choose your preferred language and set length units to Metric (mm) or 

Imperial (inch). When re-opening the Manager it will load your personal preference (these preferences 

are saved individually for each Windows user account). 

Heat setting and Ribbon Saving: you can choose to one-time override the default Windows printer 

preference setting or the pre-set value in the label document’s printer properties. The one-time manual 

override in the Manager is only applied to the loaded print job and is not saved for any future print jobs. 

In order to make an adjustment to Heat setting and Ribbon Saving persistent: adjust either the default 

Windows printer preference settings or pre-set the settings in the label document’s printer properties. 

To do this read chapter: Automate label printing process: pre-set Manager settings in a label document. 

Update Firmware: upload a firmware upgrade file or printer settings file to the printer. 
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Automate label printing process: pre-set Manager settings in a label document 
You can pre-set many of the settings in the SMS-R1 Manager window in the label document's printer 

properties if your label design software supports this. Please read Support for saving printer 

preferences at the end of this chapter. 

If you regularly print the same label document this will save you a lot of time as you don't have to 

manually set the print parameters in the Manager each time. 

How to pre-set Manager settings in label document’s printer properties in NiceLabel: 

1. Open your label design document 

2. Open the document properties 

3. Set option Use printer properties saved in to Label (default is Printer Driver). 

Note: we recommend to change this default option when creating a new label, go to: 

Menu File > Options > Designer > and set Printer Settings Source to: Use printer settings saved 

in the label. 

4. Open the printer properties and choose any specific setting you like for this label document. 

5. Click OK and save the label. 

These settings can be saved: 

- Manager settings. 

Contains options like: original or optimized dimensions, 

margins, cut shape yes/no to automatic or custom, cut 

through tape per group of # labels, etc. 

- Show SMS-R1 Manager: Yes/No. 
Yes = show Manager window to manually change options 
before sending print job. 
No = hide Manager window and directly send output to 
printer. 

- Black overprint: On/Off. 
If set to On: other colors are not punched under black 
color objects. 
If set to Off: other colors are also punched under black color objects. 
Notes about Black overprint: 
It is always automatically disabled in case a black tape is placed in the printer. 
After punch is applied, it cannot be undone while Manager window is open. If by mistake a black 
tape is in device when printing job to Manager, while it is supposed to be any other tape color, 
then later on inserting the non-black tape roll is not going to undo the undesired punch under 
black. In order to get it right, you should close the Manager, insert black tape roll in printer, then 
click "Print" in NiceLabel once more so Manager opens again. 
The other way around too: if a non-black tape roll is in printer, automatic punch under black will 
not happen when user inserts black tape roll when Manager is already open. In order to correct, 
close Manager and Print in NiceLabel again (make sure black tape is loaded on forehand). 

- Enable Ribbon Saving: On/Off. 
- Disable color: you can choose 1 specific color which will always be disabled in Manager. 

 
Note: the Number of copies and any switched/disabled colors and primer paint on/off cannot be saved. 
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Note: previously saved label files (made with driver version 17 or older) 

This functionality has been added in driver version 18, it was not available in version 17. 

If you create a new label with printer driver version 18 or newer installed it will work without any issue. 

If you however open an older label document which has been created while driver version 17 or older 

was installed at that time, you need to clear the old printer preferences cache of the document before 

the chosen settings will really be saved: 

1. Open NiceLabel. 

2. Open the label document file. 

3. Open the label document properties. 

4. Set option Use printer properties saved in to Printer Driver. 

5. Click OK. 

6. Save the label. 

7. Then open the label document properties again. 

8. Set option Use printer properties saved in to Label. 

9. Click OK. 

10. Save the label again. 

Now the new functionality will be properly saved in the label file. 

We have reserved enough memory in the Windows registry for this new functionality so this will not 

have to been done ever again, even if we add more options to the printer properties in the future. 

Note: software support for saving printer preferences 

Generally all software products which are designed for label production (like NiceLabel) support saving 

the printer preferences: you have the freedom to save specific Manager settings per individual 

document. 

For example MS Word does not support saving the printer preferences. Any choices made in the Print 

dialog window (including printer preferences) are not saved in the document. 

In this case you can only choose 1 set of specific Manager settings by setting them in the printer’s 

default printing preferences in Windows: 

1. Type CTRL + I to open Windows Settings 

2. Select Devices. 

3. Search for an option called Devices and printers and select it. 

4. Right click your printer and click Printing preferences. 

5. The settings you set here will be the default settings when printing any document. 
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Automate label printing process: hide Manager window 
You can choose to hide the Manager window by setting printer preference option Show SMS-R1 

Manager to No. 

When Show SMS-R1 Manager is set to Yes the Manager will open so user can manually set options 

before sending print job. 

When Show SMS-R1 Manager is set to No the Manager window will be hidden and it will directly send 

the print job to the printer. 

If you combine this feature with pre-setting Manager settings inside label documents, you can fully 

automate the label printing process. 

Besides these SMS-R1 specific settings, you can further automate your label print process with: 

 

NiceLabel PowerForms: build a customized print 

application for your users to prevent printing errors 

by simplifying the print process for nonskilled 

workers. Streamline complex printing processes and 

maintain label integrity. 

(requires a NiceLabel PowerForms license)  

 

 

 

 

 

 

 

 

NiceLabel Automation: create an integration 

system for fully automatic printing without having 

to do any coding. After configuring it runs as a 

service without user intervention. It is based on 

incoming print data from for example ERP systems. 

You can easily setup your data mapping. The 

incoming data is automatically processed. It can 

monitor file folders/file drop, databases and TCP/IP 

connections. 

(requires a NiceLabel PowerForms Suite license) 
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Supplies 
Please contact us for detailed specifications, article numbers, prices and our recommendation for your 

specific use case. 

Tape rolls 
A wide range of vinyl and polyester tape rolls are available: 

• ST700 Series - Premium Vinyl (16 colors available) 

• HT700 Series - High Tack Vinyl (16 colors available) 

• E300 Series - Standard Vinyl (15 colors available) 

• PT300/500/700 Series - Industrial Polyester (15 colors available) 

• PV500 Safety - VOID Polyester (1 color available) 

• H250 - High Temperature Polyester (1 color available) 

• RT500 - Reflective Vinyl (3 colors available) 

• FL200 - Fluorescent Vinyl (4 colors available) 

• RG200 - Reglo Photoluminescent (1 color available) 

Ribbon cassettes 
The ink ribbon cassettes are available in 13 spot colors: 

Black, Blue Cyan, Blue Dark, Blue Signal, Brown Pipe Marking, Green, Grey, Orange, Pink, Purple, Red, 

White, Yellow. 

Laminate tape rolls 
You can manually apply a laminate roll onto your labels after printing, just before the printer will cut out 

the label shapes. 

The laminate is a thin see-through transparent layer that will add extra protection to your label against 

hard scratching, the use of extreme (cleaning) chemicals and UV/sunlight. 
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Troubleshooting 

Various 
No Supply information is shown in SMS-R1 Manager 

The Manager application continuously queries the printer to show the loaded supplies in real-time. 

When printer is connected with a LAN connection and Manager does not show supply information, 

make sure your computer is in the same LAN as the printer, and check with IT if port 9101 is open. 

Printer Driver Installer wizard: no networked printers found 

Make sure your computer is in the same LAN as the printer, and check with IT if a UDP broadcast on port 

50020 is allowed. 

When starting a print job the printer reports the tape or ribbon is (almost) empty, but there are still 

some meters left in the ribbon cassette or on the tape roll 

When you are sure there is enough supply remaining for the required length of the print job, you can 

override by clicking on the touchscreen display. This forces the printer to use the loaded supply. 

Cut through tape per group of # labels does not work 

Upgrade your printer driver to v19d or newer, and/or your printer firmware to v3010 or newer. 

An error code is shown on the printer touchscreen display 
If something goes wrong during printing, printer can show an error code. 

Error code: 1000 / While homing the plotter, the home position was not reached within the timeout. 

Action to resolve the issue: Turn printer off, then manually move plotter knife holder to the center of 

the axis. Turn printer on. 

If you receive any of the codes below, please contact our support team to troubleshoot the issue: 

Error code: 1001 / While homing the cutter, the home position was not reached within the timeout. 

Error code: 1002 / While homing the print head lift, the home position was not reached within the 

timeout. 

Error code: 1003 / While homing the tape, the home position was not reached within the timeout 

Error code: 1004 / While ejecting the tape, the tape sensor was not deactivated 

Error code: 1005 / The temperature of the TPH has risen above the maximum value 

Error code: 1006 / The total motor current is too high 

Error code: 1007 / Power supply too high 

Error code: 1008 / Power supply too low 

Error code: 1009 / Printhead is not connected (and/or temperature sensor is out of range) 

Error code: 1010 / Fault signal of one of the motor drivers (driver board) 

Error code: 1011 / Ribbon cassette detect/lift detect 

Error code: 1012 / The print head is short circuited 

Error code: 1013 / No SPI communication between control board and driver board 

Error code: 1014 / RFID hardware is not present or defect 

Error code: 1015 / Fault signal of one of the motor drivers (control board) 
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Maintenance 

Cleaning the print head 
Link to YouTube instruction video: SMS-R1 | Cleaning the print head 

Follow this procedure to clean the print head of the SMS-R1: 

1. Power on the printer 

2. Eject and remove the ribbon cassette 

3. Power off the printer 

4. Fully open the rear transparent door to get access to the tape roll bay 

5. Unpack and unfold a 3M cleaning cloth/wipe 

6. Move your hand inside the printer and use the cleaning cloth to wipe the printhead a few times 

from left to right 

7. Check if cloth is dirty with ink residue or not so you know if the cleaning will have had a positive 

effect on the print quality of future print jobs 

Warning: do not use sharp objects (e.g. screw driver or your nails), only your fingers/hands and the soft 

cleaning cloth. Physically damaging the print head will void the print head warranty. 

  

https://youtu.be/ReurBuIprrA
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Technical support 
Contact us if you have any questions or experience an issue: 

Support e-mail address: support@rebo.nl 

Please send a detailed support request, including: 

• Printer serial number. 

• Label design software (+ version) and operating system (+ 

version) you use. 

• Label design files you are printing when the issue occurs. 

If you have linked any images or database files in your label 

please send these as well. 

• Steps you perform when the issue occurs, so we can try to 

reproduce your issue. 

  

mailto:support@rebo.nl


27 
 

Appendix 

Appendix A: How to set an Adobe Illustrator path as a cut shape 
Create a new document, set document color mode to RGB and set the Raster Effects to High (300 ppi). 

Or open an existing document and set color mode via menu File > Document Color mode > RGB Color. 

Design your shape. The cut path must be a closed path with no open endings. 

In case you want to use Adobe Illustrator to design an image file that will not (only) contain a magenta 

cut shape but also other colors: give those objects a basic RGB color value for optimal color recognition, 

and don’t use color gradients. 

For a cut shape, set the stroke weight (line thickness) to 0,09 mm or 0,283 pt: 

 

Disable the fill color and set the stroke color to RGB Magenta (R: 255 G: 0 B: 255): 

 

Print directly from Illustrator or export your design as a SVG image file and import it into your label 

design application. 

How to save as a high quality SVG file: 

1) Do not use bitmap images in the design, all artwork must be vector outlines. 
2) Make sure to convert any text in the design to outlines. 
3) Adjust document dimensions to fit artwork: select the Artboard Tool (SHIFT + O) and select 

preset: Fit to Artwork Bounds. 
4) Save as SVG, and in the SVG Options choose More Options, then set the Decimal Places to 7 for 

maximum line quality. If you don’t, it will use default value and the cut path will look jagged in 
the print/cut output result from printer. 
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Appendix B: How to set a CorelDRAW path as a cut shape 
Create a new document, set document Primary Color Mode to RGB. 

Or open an existing document and set color mode via menu Tools > Color Management: set Primary 

Color Mode to RGB. 

 

Design your shape. It must be a closed path with no open endings. 

Open the color properties of the object and set the color to RGB Magenta (R: 255 G: 0 B: 255). 

Set the Width to Hairline: 

 
 

Export your design as a high quality SVG file and import it into your label design application. 
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Appendix C: How to set an Inkscape path as a cut shape 
Open the color properties of the object and set 
the color to RGB Magenta (R: 255 G: 0 B: 255): 
 

 

 
Set the Width (line thickness) to 0,09 mm: 
 

 
  

Export your design as a SVG file and import it into your label design application. 
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Appendix D: How to set an AutoCAD path as a cut shape & general AutoCAD settings 
Document dimensions 

Maximum document dimension you can send to the printer is 103 x 2500 mm (10 cm x 2.5 meters). 

Print object color properties 

Set fill color to a RGB value for optimal color recognition in the SMS-R1 Manager. 

 

Custom cut shape properties 

The custom cut shape path must be a closed path, no open endings. 

Object properties: 

1. Color: M Magenta (RGB value: 255-0-255) 

2. Line type: Continuous 

3. Line weight: 0.05 mm 

 

We have tested cutting: (rounded) rectangle, circle and (rounded) triangle shapes in AutoCAD. 

Cutting your own custom shape/path is possible, but we cannot guarantee all shapes. 
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Create a plotter profile and adjust custom settings 

1. Open the AutoCAD document you want to print. 

2. Open the print/plot window (CTRL+P). 

3. If your design is larger than the default 103 x 300mm, you will get this warning message: 

 
Click OK and make sure to verify the dimensions of your design. 

 

In case your design is larger than default 103 x 300mm: the SMS-R1 has printing and cutting 

capability of 103mm wide (across tape direction) and up to 2.5 meter long. 

 

You can set the desired label length in Windows: go to Windows Control Panel > Devices and 

Printers > Right click SMS - R1 printer > Printing preferences > set the Label length value higher, 

then restart AutoCAD (this requires driver version 19d or newer). 

 

You can safely set a high length value, any excess (unused) space will be trimmed by the SMS-

R1 Manager application. 

 

4. Select your SMS-R1 printer in the list of printer names. 

5. Right of the printer/plotter name, click the Properties button. 

6. Select Custom Properties, then click button: Custom Properties. 

7. Note: at Custom Properties, label length is ignored: Windows printer default is used (see step 3). 

8. Depending on your design, set Orientation to Portrait or Landscape. Click OK button. 

9. Click Modify Standard Paper Sizes (Printable Area), select paper size: Custom Size and click the 

Modify button. 

10. Set all margins to 0 and click Next, Next, Finish. 

This enables you to use the complete printing width of the printer (103 mm). 

11. Click OK. 

A question will pop up regarding Changes to a Printer Configuration File: 

12. Preferably choose the second option to save your custom settings to a PC3 config file. 

Choosing option 1 results in having to set these settings each time again before each print job as 

the settings will be lost after sending the print job to the printer. 

During our testing we have made 2 profiles: 1 for Portrait and 1 for Landscape so it is easy to 

switch without having to keep adjusting settings. 

13. Click OK button again. 
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Main Plot window settings 

1. Paper size must be set to Custom Size 

2. Plot area: set What to plot to Window, and click Window button to make a selection. While 

dragging the rectangle window: make sure to keep a margin around the edges of the objects so 

they will not be clipped. 

3. Plot offset (left): enable option Center the plot. 

4. Plot scale (center bottom): disable Fit to paper and set scale 1:1 (equivalent of 1 mm = 1 unit). 

5. Drawing orientation (bottom right): set similar to what you have chosen in Create a plotter 

profile and adjust custom settings step 7. 

6. Click Apply to Layout button and click OK to send the print job. 
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Appendix E: How to set a Bartender path as a cut shape 
Double click a shape to open its properties window. 

Set the Line Thickness to 0.1 pt and the Color to M Pink (Magenta). 

 

Alternatively, you could design a custom cut shape with Adobe Illustrator, CorelDRAW or Inkskape and 

import the image file into your Bartender label design. 

 


